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Introduction :

Providing healthcare services IS COMPLEX!

Health care organizations use policies and procedures so
they can reduce this complexity.

In most health organizations, priority is given to direct
patient care. However, managers need to write, review or
update policies and procedures.

Well-written, up-to-date policies and procedures reduce
practice variability that my result in substandard care and

patient harm.

Therefore, maintenance of policies also ensures reduced
risks (malpractice, claims. Etc.).



What is a policy?

* Policy: A set of principles outlining the
context, goal, or purpose of an organization to
guide decision making (action and inaction) in
relation to processes or activities that take

place or might be expected to occur (Hollnagel
et al., 2014).



Examples of hospital policies

Policy:

Promoting Natural Childbirth.
Attention to patient safety.

Medication shall be administered by a qualified
registered nurse only upon a written physician’s
order.

Employee should provide three months notice before
terminating his/her contract

Employer should give the employee a month notice
before terminating his/her contract



Procedure?

Procedure: The desired, intentional action steps
to be taken by specified persons to achieve a
certain objective in a defined set of
circumstances.

l.e. How to carry out the policy!



Policy vs procedure

e Usually expressed in
broad terms

e States “what” or “why”
e Changes less frequently

e Describes values,
philosophy of the
organization

e Usually stated in detail

e States “How” and
“Who” and “When”

* Prone to change
e Describes process



Procedure

How does the
employee request
contract termination?

Employee should
providethree months
notice before
terminating his/her How to fill out the
contract form?

How to track the
request?

Who is responsible
for processing the
form?



Protocol: Synonymous with procedure. Often
used when describing clinical patient care-
related interventions.

For example, a chemotherapy protocol or
protocol to quality healthcare delivery.

Guideline: Recommended actions for a specific
situation or type of case.

For example, A clinical practice guideline that
outline blood-testing practices for patients
who are taking anticoagulants.



UCSF COVID-19 ID Clinical Working Group

Last Updated: March 4, 2020

COVID-19 Adult Clinical Evaluation Guide

Consider COVID-19 in a patient
with any of the following:

* Fever

* Cough

* Shortness of breath

* High risk travel/exposure

Cli

nical Signs/Symptoms

Fever seen in >75% of hospitalized cases at some
point but almost 50% are afebrile on admission
Cough 60-80% (dry or productive)

SOB 20-40%

URI symptoms (HA, sore throat, rhinorrhea) in <15%
Gl symptoms (diarrhea, N/V) in <10%

Labs

* Check CBC with diff, BMP, LFTs,
procalcitonin

* Clues to COVID-19: leukopenia,

Labs and biomarkers

Median WBC 4.7, with leukopenia in 30-45%
(leukocytosis in <5%)

Lymphopenia in 33-85%

Median platelets normal, but slight decrease in 35%
AST/ALT increase in 4-22%

lymphopenia .
e i * CRPincreased in 61-86%, LDH increased in 27-75%
l * PCT: 20.5 in 5.5% overall (14% if severe, 24% if ICU)
Microbiology Microbiology

* Check rapid flu/RSV, RVP
* Consider blood cultures,
sputum culture

* Clues to COVID-19: absence of
other pathogens

Coinfection rate with viruses and bacteria is
unknown but is low in published studies to date
The presence of an alternative viral etiology (eg
influenza) makes COVID-10 less likely (exception:
rhinovirus since this is a common co-pathogen)
Bacterial coinfection might increase with severity of
illness so bacterial infection in a severely ill patient
does not exclude COVID-19

Imaging

* CXRin all patients

* If CXR (-), consider CT for better
sensitivity for PNA and to
exclude alternative dx

* Clues to COVID-19: bilateral,
GGO, peripheral distribution

Imaging

CXR abnormal in 60% (77% if severe), chest CT
abnormal in 86% (95% if severe)

Unilateral findings on CXR or CT in 14-25%
(especially if mild or early in disease)

Most common findings: GGO and patchy
consolidations (>50%), peripheral distribution >50%
Nodules, LAN, cystic changes, effusion in <10%

Flowchart to Identify and Assess 2019 Novel Coronavirus

For the evaluation of patients who may be @l with o who may have been
exposed 1o 2019 Novel Coronavirus (2019-nCoV)

Iden

M iy the past 14 days since first onset
» Close contact with
Travel to China T OR=—p 2 Person known to have
2019 nCoV diness*

Fever or symptoms of lower n&&:noq iliness
{e.g., cough or shortness of breath)

if both exposure and illness are present

N

+ Place facemask on patient
+ Isolate the patient in 2 private room OF A SePIrate aea
+ Wear spproprate personal protective equipment (PPE)

Assess clinical status

Is fever present? Is respirat,
| Subjective? 1Cough?

TTMeasured? ___ CF "I Shortness of breath?

y Hiness p ?

» Contact health department to report atrisk patients and their dinical status
» Assess need to collect speciment to test for 2019-nCoV
« Decide dispostion

If discharged to home

Instruct patient
As needed depending on severity of iliness and health department cons uftation

* Home care guidance
» Home isolaton guidance

Advise patient
¥ the patient devdlops new of worsening fever or respicatory liness

» Call dinic to determine if reevaduation is needed
« If reevaluation is needed call ahead and wear facemask
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The Purpose of Policies and Procedures

Formalized, written policies and procedures fulfill a number

1.

2.

of important purposes:

Ensure adherence with recognized professional practices
therefore reducing practice variation (standardization).

Promote compliance with regulations. (i.e. All policies and
procedures should not contradict with the government
rules and regulations and MOH policies and procedures).

Can be used to ensure adherence to the accreditation
requirements

Help staff understand their roles and responsibilities
within the organization. particularly new personnel.

Reduce reliance on memory, which has been shown to be
a major source of human errors.



Types of hospital policies and procedures

There are several types of hospital policies and procedures but the main ones are :

* Philosophical
— Code of Ethics
— Mission
— Vision
— Organizational values
— Code of Conduct (specific situations)

— Communication culture

(Effective communication keeps internal processes running
smoothly and helps to create positive relations with people
both inside and outside the organization).



Types of hospital policies and procedures

* Administrative
— General Rules and regulations
— Leaves, personnel processes
—Smoking and environmental health policies
—Security policies
— Staff development
— Total quality management policies



ADMINISTRATIVE POLICIES & PROCEDURES MANUAL

Policy Covering:  VISITING HOURS

Effective Date: September 2010

Reviewed: May 2013 Category: Patient Administration Policy # 602
Revised: March 2015
Prepared By: :r‘:; z:“E“‘ Care | < persedes Policy §/Dated: May 2013 | Page 10f 1

-
1ssued By: President/ CEQ < T T—

Palicy: It is the palicy of the hospital to provide a patient centered approach to care.  In an effort to
balance patient neads with nursing/therapeutic/diagnostic care, the haspital has established the
following criteria for visiting hours.

1. General Criteria

a. The hospital is open for visiting during the hours of 0800 to 1830 and 1930 to 2200. Health care
staff has the discretion to direct visiting in order to meet the health care needs of the patient
and to address security issues during the evening/night;

b. Visiting criteria do not apply to clergy/chaplains;

€. Short visits are encouraged as patients need to rest, unless visitors are providing care for their
loved one, ie. feeding, keeping the patient from harming themseles;

d. Generally visitors will be restricted to two (2} at a time;

&. There will be times that visitors will be asked to leave the patient room. Examples of these
instances are: if any patient in the room requires nursing care or treatment during a visit; the
room needs cleaned; and others as they arise, Visitors will be discouraged fram staying in the
halls and will be asked to use the quiet room or day room;

f.  Children under twelve (12) years of age are only permitted to visit provided they are well
behaved and supervised at all times by an adult; and

g. Children under twelve [{12) years of age will be restricted from visiting patients with C. diff.
Other ARD patients may also have restrictions based on the organism/circumstances.

Exceptions for specific types of patients




Types of hospital policies and procedures

* Human Resource Management Policies

* To ensure that the staff are complying with the
rules and regulations of the organization, as well
as, being taken care of.

* To improve the staff’s skills as the primary focus
of the department.

EXAMPLES: vacation days, personal hygiene
maintenance, dress code, shift policies, as well
as, assigning tasks to each individual.



Types of hospital policies and procedures

* Information Management Policies

 How a hospital shares its information. This information can
be related to a staff member, patient, or a visitor.

* Itis veryimportant for an organization to ensure everyone
is following a strict code of privacy and is not violating
anyone’s right.

Include: confidentiality, security and integrity of information,
medical records distribution.

* Ensure that the policies and procedure manuals are well
organized and easily accessible.



Types of hospital policies and procedures

SHORT,
INTERNAL COMMUNICATION

* Memo policies
—Management notification or short report
— General distribution
— Delegation of authority



Memo

Tex [Click here andtypename]
Frone  [Clickhere andtypename]
cC: [Clickhere andtypename]
Datex July7, 2015

Re: [Click here and type subject]

How to Use This Memo Template

Select the text you would like to replace, andtype your memo. Use styles such as Heading
1-3 and Body Text from the Styles and Formatting work pane from the Format menu. To
save changes to this template for future use, choose Save As from the File menu. In the
Save As Type box, choose Document Template. Next time you want touse it, choose New
from the File menu, select General Templates from the work pane. and then double-click
your template. r
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POLICY MEMO
DATE: January 1, 2009
TO: All Employees
FROM: Headquarters Accounting & Finance Department
SUBJECT: Business Travel and Expense Policy

EFFECTIVE: January 1, 2009

TRAVEL

All business travel must be approved and reasonable expenses discussed with the
immediate supervisor in advance of travel and prior to incurring expenses.

A. Travel Arrangements

Every effort should be made to make advance travel arrangements to minimize
costs to the Company. Whenever possible, employees are to arrange transportation
in the least expensive way possible by securing available discounts and special
rates by booking their own travel through on-line reservation systems.

B. Travel by Air




Memo

To: PHCS Employees
From: Human Resources Department
Date: August 2011

Re: Volume 5 Human Resources Policy Changes and Additions.

Amendments have been made to the Volume 4 - Hurnan Resources Paolicies and Procedures to reflect
current Preferred Health Care Services practices and legislative regulation changes, which are effective
immediately.

In addition we have implemented new policies that have been added to the Volume 5 Policies and
Procedure Manual.

You will find a summary document which highlights all of the changes to current policies and a brief
summary of the new policies implemented. Please familiarize yourself with the changes and the
additions by reading the summary document, the entirety of the new policies which you can access by
contacting Christina Rizek, Recruitment & Employee Relations Analyst. If a specific policy is not included
on the summary document then it did not require any major changes.

If you hawve any inquires or concerns, please direct them to your Manager or designate.
Thank you

Human Resources



It is the responsibility of
each Department Head to
develop policy and
procedure within their
scope of service

The Department Head
cooperate and coordinate
inter-related departmental
policies.

TQM Departmentis
responsibleto provide
assistancetothe
departmentsto develop
their policy and procedures.
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How Do You Formulate or Write a Policy?

Before writing

Implementing



How Do You Formulate or Write a Policy?

Before You Begin Writing Policies

eClearly define the problem the document should
address

eFind current policies in place

eCreate a standard policy format

e Appoint a policy team

eReview regulations and accreditation standards



o oo Lo
P &P writing

* Define all terms used within the policy
e Select a simple, recognizable name for the policy.

 Combine separate policies on the same subject into
one policy. If it becomes long, create a table of
contents so the user can easily locate specific sections.

* Ensure responsibility for carrying out each action step
is explicitly stated, not implied.

e Refrain from using superlative words or statements,
such as:

a) Highest, safest, best (level of care)
b) Assure, ensure (preferable to use “to promote”)



I

e Establish naming and numbering conventions
for use across the health system.

Number all pages, reflecting the total number of
pages as well: page 1 of 5, 2 of 5, etc. Put the
policy title/number in the header of each

page.



Approvals

» The one who prepared the policy should sign it

» If prepared by a group, then an additional approval
sheet is attached to the policy with the signature of
all members of the group.

» The leader of the group signs on every page of the
policy.

» Interdepartmental policies should be reviewed
and singed by all department heads concerned.



Approvals

» All policies and procedures are reviewed and signed by
the Total Quality Management Department

» All policies and procedures should be approved by the
following division heads as applicable and their official
stamp affixed as appropriate




Policy Implementation

» Implementation process involves:
— Distribution
— Familiarization
— Actual practice
— Monitoring



Policy Implementation/Distribution




Familiarisation and actual practice

* Train employees on the new policy

Training helps employees see how policies apply
to them. It walks them through how to
properly follow procedures.

 Monitor policy compliance and effectiveness



Monitoring ROa04

It is recommended that all policies and ‘
procedures are subject for review every two (2)
to 3 years and revised as needed (nature of

policy).

To ensure multidisciplinary approach to the
services provided in the hospital, all policies
shall be reviewed by a multi-disciplinary
team.



Policy Analysis

The process of predicting the impacts of
possible policies (prospective) and evaluating
past policies (retrospective)



Policy Termination

» Policies should be terminated when cancelled by a
later policy

» A policy may be terminated by authority of the
Program Director



Electronic Policy Libraries

 Most healthcare organizations have replaced paper
policy and procedure manuals with electronic policy
libraries

* To optimise the usefulness of
electronic libraries:

1. Provide indices by policy name, subject, and
sponsoring domain (administration, nursing,
pharmacy, etc.)

2. Incorporate “word search” functionality in order to
facilitate searches for pertinent policies irrespective of
their issuing domains.

3. Do not prohibit access to policies of one domain to
personnel in other domains. persons in other
departments may need to refer to those documents.



4. Immediately remove a policy that has been
officially retired or replaced from the “active”
database and transfer it in the designated

archives.

5. Create an electronic archive for storing “retired”
or prior versions of policies. This will facilitate
access in response to legal discovery requests.

6. Check with your corporate compliance office
regarding organizational document retention

policies.

=
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Thank
you

It was just poor
management. Looking at
it from a professional
point of view, the
procedures and policies
weren't there to control
things.

Frank Rawa
QUOTEHD.COM
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